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Packet 
 

 

 

 

 

 
This MLA packet helps students organize the Works Cited page, format parenthetical 

references, and apply the basic structure of an MLA paper. 

 

 

These handouts conform to the MLA Handbook 9th edition standards.  However, a professor 

may change the requirements for individual papers.  Please consult the professor for any 

special requirements.  
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Sample First Page  

(“Formatting a Research Paper,” MLA Simplified) 
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Student 1 

  Ima Student                                                                  

  Professor Lastname 

  ENGL 1301.03 

  1 September 2021 

   Title of Essay 

 Xxxx xxxx xxxxxx xxxx xxxx xx x xxxxxxx xxx x xxx xxxxxxxxxx xxx xxxxx xx 

xxx xxxxx xxx x xxxxxxx x xxx xxxx xxx xxxx x xxx xxx xxxx xxxxx xx xx x xxxxx xxxx 

xx xxxxxx xx xxx xxxx xxxxx xxxx xxxx xxxx x xx xxx x xxxxx xx xxxxx xxxx xxxx xxx 

xxxx xxx xx x xxx xx xxxxx. 

 Xx xxx xxxx xxx xxxx: 

Xxxxxxx xxx xxxxxxx xx xxxxxxxx x xxxxxx x xxxxxx x xxxxx xx xxxx xxx 

xxx xxxx xxxxx xxxxxx xx x xxxxx xx x xxxxxxxxx xxx xxxx xxxxx xx 

xxxxx x xxxxx xxx xxxx x xxxxxxx xxxx x xx xxxx xxxxxxxxx xxxxxxx 

xxxx xxx x xxxxxx x xxxx xxx xxxxx xxxxxx x xxx xxx xxxxx xxxx xxx 

xxxx x xxx xxxxxxx x xxx xxxxxxx xxx xxxx xxx xx xxx xxxxxx x xx xxxxx 

x xx xxxxx xxxx. 

 Xxx xxxx xxxxxxxx xx xxxxxx x xxxxx xxx xx xxxxx xxxxx xxxxx xxx xxxxx x 

xxxx xxx xxxx x x xxxxxxx xxxxxxx. Xxx xxxx xxxxxxxx xx xxxxxx x xxxxx xxx xx xxxxx 

xxxxx xxxxx xxx xxxxx x xxxx. Xxx xxxx xxxxxxxx xx xxxxxx x xxxxx xxx xx xxxxx 

xxxxx xxxxx xxx xxxxx x xxxxxxx .xxxxxxx. xxxxxxxx. 

Heading begins 1” from the 

top of the page.  

Spacing between all paragraphs, 

headings, and titles should be the 

same as between all other lines. 

Tab once before all paragraphs. 

Tab once 

for quotes 

longer than 

4 lines  

(MLA 

Handbook, 

pp. 254-5). 

Bottom and top margins are 

set to 1”. 

Do not italicize or underline 

title. Do CENTER it. 

According to the 9th ed. of the 

MLA handbook, the last name 

and page # go on every page (See 

“Formatting” below). For details, 

see “Running Head,” pp. 3 of the 

packet.  

Spell out month. 
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MLA Basics 
Title page (“Formatting,” par. 1) 

MLA prefers no separate title page; MLA papers hold a four-line heading and a title directly before the first 

paragraph (see pp. 2 of packet).  If the professor wants a title page, follow his/her instructions or follow the 

guidelines for the Generic Title Page, located at http://www.dbu.edu/uwc/flyers.asp or outside of the Writing 

Center in the basement of Collins Learning Center. 
 

Margins (“Formatting,” par. 1.1) 

Set margins at one inch on all sides of the page. Fix headings to one inch, as well. In Microsoft Word, select 

“Page Layout.” Then, find the “Margins” drop-down box and select “Normal.” 
 

Text Formatting (“Formatting,” par. 1.2) 

Many students want to justify the lines of the text at the right margin; however, MLA format requires left 

justification.  Choose “Align left,” which is usually the default. If a professor fails to request a specific font, use 

Times New Roman, 12 point; MLA also now accepts 11-13 font requiring it in some headings. Double-space 

everything, including the title, text, block quotes (quotes longer than four lines), and the Works Cited page. Since 

double-spacing produces a blank line after paragraphs, headings, and titles, never press “Enter” to add an extra 

space. In Microsoft Word, go to the “Home” menu. Then, find the “Paragraph” section and click the small arrow 

in the bottom right corner. Under the “Line Spacing” section, choose “Double.” Finally, check the “Don’t add 

space between paragraphs of the same style” box. Completing this process in the “No Spacing” block creates a 

tighter, neater paper. For more help, see the video on our YouTube channel: 

http://www.youtube.com/watch?v=H5bUIVCJltY. 
 

Page Headers (“Formatting,” fig. 1.1) 

MLA calls for both a header and a heading, now called a running head. A running head sits half an inch from 

the top of the page and includes the student’s last name and the page number. This information appears on every 

page of the paper. To create the running head, double click at the top of the page. Under the “Insert” tab, find 

the “Page Number” drop down menu, select “Top of Page,” and choose “Plain Number 3.” Then, click the left 

arrow key once so that the cursor lands on the left side of the number. Type last name. Make sure to leave one 

space between the name and the page number, and change the font of both to Times New Roman 12 point. If an 

extra line appears below the last name and page number, remove it before exiting out of the header.  
 

The header shows up on the first page only and includes the student’s full name, professor, class designation, 

and date. When writing the date, include the day, the month, and the year in that order (see pp. 2 of packet). 

Double space this header like the rest of the paper and make sure it shows one inch from the top of the page. With 

margins correctly set, computers allow no typing above that point, outside of the page’s header box (see pp. 2 of 

packet). 

 

Internal Headings: Title and Subtitles (Formatting, par. 13, 1.5) 

MLA now utilizes up to five levels for headings that alert readers to shifts in focus within a work. Use short, 

succinct headings and rely on these guidelines (par. 1.3): 

 Large bold fonts mean prominence while smaller italicized lettering stand subordinate. 

 Avoid using all capital letters. 

 Eschew numbers and letters unless so directed by the professor. 

 Level 1 stands bold, flush left and at 13 pt. size. 

 Level 2 remains plain, left flushed, and also in 13 pt. 

 Level 3 uses italics in 13 pt. and flush left. 

 Level 4 drops to 11 pt. and sits flush left plain. 

 Level 5 returns to italics retaining the smaller 11 pt. font, also flush left. 

 Always begin the text indented in a new paragraph. 

 Use level headings sparingly.  
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Writing the Paper & Citing the Sources 
 

Indents (“Text Formatting,” par. 1.2) 

Tab once before all paragraphs (half an inch) and tab once for block quotes (those longer than 4 lines).   

 

Names and Titles (MLA Handbook, pp. 42-51, 227-30) 

When using a source the first time within the text of the paper, give both the first and last name of the author 

exactly as they appear in the source. After that, only mention the last name. Italicize the titles of complete works 

(books, anthologies, newspapers, paintings) and quote unit titles (chapters, articles, essays in a collection, songs). 

 

Using Numbers (MLA Handbook, pp. 82-7) 

For subjects such as literature, which rarely use numbers, spell them out if they translate into one or two words. 

Use Arabic numerals with proper comma usage for longer numbers (Ex: 1,576). If a paper frequently employs 

numbers for mathematics, economics, etc., use the Arabic numerals (1, 2, 3, etc.). If not part of a statistic, spell 

numbers out (Ex: For fifteen years, Smith conducted this research). 

  

Citing Sources in an MLA Paper (MLA Handbook, pp. 227-286) 

In parentheses, after the quote or paraphrase, type the author’s last name and the page number without a comma 

between them (see “Differences in Quoting, Paraphrasing, and Summarizing” flyer). 

 

Works Cited Page (MLA Handbook  pp. 5-6, “Formatting,” par. 1.6) 

If citing sources within the paper, place a Works Cited page at the end. Begin the list on its own separate, titled 

(Works Cited) page with progressive numbering. Double-space everything on the Works Cited page(s). Align 

the first line of each reference left, indenting any information that follows one space. Create a hanging indent; 

include detail as MLA demands. See pp. 5 of this packet or our YouTube tutorial 

(https://www.youtube.com/watch?v=S2fg4JFHnkM) for instructions on creating a hanging indent.  
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Sources in the Paper – Parenthetical Notation (MLA Handbook, pp. 227-52) 
 

 

 

Circumstance What to Include in Parentheses Example 
Author’s name omitted from the 

sentence 

Author’s last name and page number. 

 

(Smith 41). 

See MLA Handbook pp. 229. 

Author’s name included in the 

sentence 

Page number only. According to Smith… (123). 

See MLA Handbook pp. 229. 

Multiple works by the same 

author 

Author’s last name, one major word from the 

title of the work, and page number with no 

comma between title and page number 

(Smith, Characters 98). 

 

See MLA Handbook pp. 235-6. 

A work with two authors Both authors’ last names in the order they appear 

on the title page. 

(Gray and Dunn 75). 

See MLA Handbook pp. 232-33. 

A work with three or more authors First author listed, followed by “et al.” (McFluffy et al. 1337). 

See MLA Handbook pp. 232. 

 

A work with no author 

The word by which the title is 

alphabetized in the Works Cited and the page 

number. Italicize or “quote” based on type of 

work. 

 

(“Dreams” 52-53). 

 

See MLA Handbook pp. 239, 

313. 

 

 

A work with no page numbers 

Preferable to use the author and title in the text, 

only including the paragraph number in the 

parenthetical notation. 

Otherwise, use author’s last name as well as the 

paragraph number in the parenthetical notation. 

John Krasinski’s How to Prank 

Your Coworkers claims that 

the…stopped. 

or 

(Krasinski). 

See MLA Handbook pp. 248. 

A multivolume work, if using more 

than one volume 

Author or editor, followed by volume number, a 

colon, then page numbers. 

(Darnel 3: 212-13). 

See MLA Handbook pp. 249. 

 

 

A document from the internet with 

no page numbers or paragraphs  

 

Preferable to use the author and title in the text. 

Otherwise, use author’s last name in the 

parenthetical notation. 

Dwight Schrute’s Bears, Beets, 

Battlestar Galactica claims that 

the…  

or 

(Schrute) 

See MLA Handbook pp. 248. 

An electronic book with universally 

consistent location number 

Author’s last name and the location number.  (Brown 

www.jstor.org/stable/41403188). 

See MLA Handbook pp. 244. 

An electronic book with universally 

inconstant location and page numbers 

Author’s last name and the chapter number. (Jones ch. 5). 

See MLA Handbook pp. 244. 

 

A poem 

Line numbers. Place two slashes between each 

line. If more than three lines, indent each new 

line instead of using slashes 

“I learned about a virgule. // It is 

another name for slash (Griffin 

332-33). 

See MLA Handbook pp. 155-6. 

A play 

 

Act number, scene number, line number(s), 

separated by periods. 

(2.5.79-81). 

See MLA Handbook pp. 158-9. 

Indirect Source Use the abbreviation “qtd. in” before citation; not 

needed if clear in text. 

(qtd. in Rogers 4). 

See MLA Handbook pp. 284. 

 

 

With non-blocked quotes (those of 4 lines or less), the period goes after the end parenthesis. With block 

quotes, type a space after the ending punctuation mark of the quotation and then type the parenthetical 

reference. Do not use quotation marks. 
 

The following example shows a correct ending for a block quote: 

Playing with The Grass Roots was much more difficult than playing the role of Creed on The 

Office. (Creed Bratton 115) 
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  Printed Sources in the Works Cited (MLA Handbook pp. 5-6, 105-175.) 
 

▪ Double-space the lines of the Works Cited page. 
 

▪ Include available author, title, and publishing information in each entry. For publishing companies 

containing the words “press” or “university” use “P” and “U,” respectively (E.g. HarperCollins P, Dallas 

Baptist U). 
 

▪ Arrange entries in alphabetical order by author’s last name. Use the first author if a work shows several. 

If no author appears on the work, alphabetize that entry using the first significant word of the title (i.e. 

The Season of Surgery before Summertime Love = Season of Surgery Before Summertime Love). 
 

 

▪ Align entries to the left and indent subsequent lines one tab. To automatically create a hanging indent, 

highlight the Works Cited list, click the small arrow button in the bottom right of the “Paragraph” 

section of the “Home” tab, find the “Special” section under “Indention,” and choose “Hanging.” For 

more help, see this video on our YouTube channel: http://www.youtube.com/watch?v=S2fg4JFHnkM. 
 

▪ Use one space after a comma or period and finish each entry with a period. 
 

▪ Some sources are part of a larger whole, such as articles in newspapers or magazines. Think of the larger 

whole as a container, and italicize it. Follow it with a comma because the information following it refers 

to the container, not the article (pp. 134-45). 
 

▪ If there are volume or issue numbers, include them after the title of the publication in the format volume 

number, period, no space, issue number (See the “Scholarly Journal” section on pp. 6 of this packet for 

an example). 
 

Book with One Author (MLA Handbook, pp. 313) 

Lott, Brett. Jewel. Pocket Books, 1991.  
***Electronic books are also cited in this way on a Works Cited page.  

 

Book with Two Authors (MLA Handbook, pp. 313) 

Goshgarian, Gary, and Kathleen Krueger. Crossfire: An Argument Rhetoric and Reader. HarperCollins, 1994.  
 

Book with Three or More Authors (MLA Handbook, pp. 313) 

Smith, Maxine, et al. CoreText: A Handbook for Writers. Longman, 1997. 
 

Two or More Books by the Same Author (MLA Handbook, pp. 235-6) 

Angelou, Maya. And Still I Rise. Random House, 1978. 

 

---.  I Know Why the Caged Bird Sings. Random House, 1978.   
***Cite the first normally. Use three hyphens and a period for every subsequent entry. They should be together in 

the Works Cited page. 

 

An Edition other than the First (MLA Handbook, pp. 315) 

Strayer, Joseph, et al. The Mainstream of Civilization: 1350 to 1815. 2nd ed., Harcourt Brace Jovanovich, 1974.  

 

Book with an Editor as Author (MLA Handbook, pp. 314) 

McKeon, Richard, editor. The Basic Works of Aristotle. Random House, 1941.  

 

Book with an Author and Editor (MLA Handbook, pp. 314) 

Conrad, Joseph. The Secret Sharer. Edited by Daniel R. Schwarz. Bedford Books, 1997.  
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A Work in an Anthology (with an author) (MLA Handbook, pp. 225) 

Ibsen, Henrik. Hedda Gabler. Translated by Michael Meyer. The Norton Anthology of World 

 

Masterpieces, edited by Maynard Mack, 5th ed., vol. 2, Norton, 1995, pp. 1247-1304.  
***Include the page numbers of the entire work, not just the portion quoted. 

*Because the specific work was translated, the translator comes before the complete collection, also known as the 

container. The details about the container follow its name and are separated by commas. 

 

A Work in an Anthology (with no author) (MLA Handbook, pp. 107-8) 

Gilgamesh. Translated by N.K. Sandars. The Norton Anthology of World Masterpieces, edited by Maynard  

 

Mack, 5th ed., vol. 1, Norton, 2002, pp. 83-86. 
***Include page numbers of the entire work, not just the portion quoted. 

***In this instance, Gilgamesh is the primary source, and therefore, the details following are separated from the 

title with a period. The container’s details, however, are still separated by commas. 

 

A Multivolume Work (MLA Handbook, pp. 316) 

Individually titled: 

Hester, M. Thomas. John Donne. 1990. Vol. 121 of Seventeenth-Century British Non-Dramatic Poets.  

 

Dallas Baptist UP, 1992.  

 

Individually titled with an editor: 

Davis, Cassandra. Frightening Fairie Spells. Edited by Alexander Baudelaire, 1997. Fairies, Dragons, and  

 

Phoenixes in Old Time Lore, Vol. 5, Umbridge P, 1995-2000. 

 

Entire multivolume set: 

Ebony, Charles. The History of Time Pieces from Sundials to Apple. 3rd ed, Watchman P, 2017. 12 vols. 

 

One Volume from collective title: 

Cantor, Olive. A Dummy’s Guide to Dressage Showmanship. Vol. 9, Clydesdale and Morgan Books, 2005.  
***Students may include the total number of volumes in a multivolume publication, though MLA does not 

require it. However, that inclusion may aid in tracking down the original source. Always, specific 

references to volume number and page numbers must be included in the parenthetical reference. 

 

Newspaper Article (MLA Handbook, pp. 321-2) 

Hoppe, Christy. "Majoring in Change." Dallas Morning News, 18 Jan. 2000, 1A. 
*** If adding edition (late edition., special edition., etc.), it goes after the periodical title, separated by a comma. 

***Always include denotation of the section in which the article resides. In the example above, 1A refers to page 

1 of section A. 

***Add web address when accessing via the web. 
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Scholarly Journal (MLA Handbook, pp. 319-321) 

Kastely, James L. "From Formalism to Inquiry: A Model of Argument in Antigone." College English, vol. 19,  

 

no. 2, 1999, pp. 222-241. 
** *  no. 2 represents the journal issue number 2.  

  *** See manual for additional information, such as those including issue number, season, corporate authors, 

translators, other than English versions, multiple series, special issues, DOIs, permalinks, online-only journals, 

PDFs, supplementary data, online ahead of print, and entire special issues. 

 

Magazine Article (MLA Handbook, pp. 323) 

Simple version without season, volume or issue numbers: 

Johnson, Brace, and Alisa Johnson. "Integrating with MTS." International Spectrum, May 1999, pp. 24-31. 

Including additional information such as season, volume and issue number: 

Johnson, Brace, and Alisa Johnson. "Integrating with MTS." International Spectrum, vol. 5, no. 2, pp. 24-31. 
***Volume and issue number, if applicable, follow the title of the periodical. 

 

Pamphlet or Brochure (MLA Handbook, pp. 340) 

Texas Rangers Museum. Texas Association of Museums. TAM, 2013. Brochure. 

 

Dallas Baptist University Highlights. Student Affairs. Hawkeye, 2020. Pamphlet. 

 

Electronic Sources in the Works Cited 
 

For the most part, the same important information for a printed source must be reported for electronically 

accessed sources. However, professors expect inclusion of essential items. Since the internet constantly 

changes, the UWC recommends including access date of the article. 

 

World Wide Web (MLA Handbook, pp. 324-7) 

When citing an item from the World Wide Web, use the examples below or check the manual. MLA now lists 

almost anything a scholar might consider using individually. General instructions no longer exist in the manual. 

 

Books found online (MLA Handbook, pp. 324-5)  

Fowler, Karen Joy. The Jane Austin Book Club. 1971. Heathcliff Digitizers, 1998, 

http://heathcliffonlinebookshahah/468246. 

Printed book accessed through a database (MLA Handbook, pp. 325)  

Collins, Suzanne. Mockingjay. Scholastic Press, 2010. Scholastic Online Enterprises,  

 http://ifunfantasy.collins.readalot.doi.org425198400078. 

Electronic scholarly journal found in a database (MLA Handbook, pp. 325) 

Macready, Norra. "US State Rules that a Viable Fetus is a Person." British Medical Journal, no. 315, 

 1997, pp. 1485-8. JStor, www.jstor.org/stable00000. 
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News Publication (MLA Handbook, pp. 326) 

Culpepper, Quita. “Why Austin Stays Weird.” Austin Daily Times, 13 Jun. 2019, 

www.AusDTimes.com/localinterest/stayweird/havefun. 

Online Database Accessed from a library (MLA Handbook, pp. 138-45) 

Harper, Kayla. “The Dramatic College Experience.” The Writing Center Project, vol. 2, no. 2, May 2020. 

JSTOR, www.jstor.org/stable/123456789. 

Blogs (MLA Handbook, pp. 326) 

Yeats, William Butler. "When You Are Old.” On Aging Well Tips and Tricks, 15 Sept. 2021.  

 

www.theagingwellonlinenewssourcee/tips-and-tricks. Thoughts on Aging. 

Social Media (MLA Handbook, pp. 326-7) 

Bards Blues Tweet [@EnglishNerdsRock]. “To die or not to die with or without a mask while arguing the 

political merits of freedom.” Twitter, 3 Aug. 2021, 

twitter.com/PlaceTheWholeLinkHereNumbersToo. 

Karina, Karina [@KarinaKarina]. “Why Can’t the Writing Center Use TikTok? #WritingCenterWork.” TikTok, 

2019, www.tiktok.com/karinakarina/video/0004443337770437. 

Collins, Theresa. Cover of Doll Up That Planner with Junk Journaling by Louise Umke. Pinterest, 2019,  

www.pinterest.com/pin123456789987654321/. 

Handshake. “Getting a job in the fast lane requires many soft skills and many…” LinkedIn, 2019,  

www.linkedin.com/posts/handshake/job-searching-advice-45678913253987z. 

Feral Cats Community. “How to Trap-and-Release in Your Neighborhood.” Facebook, 11 Aug. 2021,  

www.facebook.com.andTheWholeLinkGoesHere/Really/IncludingNumbers/. 

YouTube (MLA Handbook, pp. 329) 

“Harlem Shake Dallas Baptist University (Ballpark Edition) [OFFICIAL].” YouTube, uploaded by Laessig, 

Jordan, 15 Feb. 2013, https://www.youtube.com/watch?v=1Kl4rNUTWCA. 

Movies or videos (MLA Handbook, pp. 328) 

The Semester at Hand. Directed by Adam Wright, Campus Distributors, 2021. 

 *If viewed other than at theater, please consult manual for additional information, pp. 328-9. 

 

Television (MLA Handbook, pp. 329) 

Single episodes from the web 

“A More Perfect Union.” Person of Interest, season 5, episode 6, CBS, 23 May 2016. CBS, 
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www.cbs.com/shows/person_of_interest/video/3A7F7A9A. Accessed 29 May 2016. 

*If viewed through other mediums, such as broadcast, social media, or an app, please consult 

manual pp. 329. 

Miscellaneous 

Audiobook (MLA Handbook, pp. 330) 

Stockett, Kathryn. The Help.  Narrated by Jenna Lamia, Bahni Turpin, Octavia Spencer, Cassandra Campbell,  

 

audiobook ed., unabridged ed., Penguin Audio, 28 December 2009. 

Art 

Exhibition (MLA Handbook, pp. 331) 

Baker, Dawn Waters. Landscapes. 18 May 2013, Mary Tomas Galleries, Design District, Dallas, Tx. 

 

Sculpture (MLA Handbook, pp. 331) 

Lord, Chip, Hudson Marquez and Doug Michels. Cadillac Ranch. 1974, Amarillo, Texas. Metal sculpture. 

 

Painting (MLA Handbook, pp. 332) 

Sully, Thomas. Cinderella at the Kitchen Fire. 1843, Dallas Museum of Art, Dallas, Texas. 

*if viewing online, by book, or other medium, see MLA Manual pp. 332. 

 

Play (MLA Handbook, pp. 334) 

Pirandello, Luigi. Six Characters in Search of an Author. Directed by Kayla Harper, Rambunctious Stage  

 

Productions, 11 June 2021, Crighton Theatre, Conroe, Texas. 

Interview (MLA Handbook, pp. 336) 

Baggins, Frodo. “My Life as a Hobbit.” Interview by George Stephanopoulos. Good Morning America, ABC,   

 

          29 Feb. 2010.  

*** For additional information on various differences, especially personal interviews, consult MLA 

manual.            

E-mail and/or Texts (MLA Handbook, pp. 32) 

Sanchez, Deneen. E-mail to the author. 12 August 2021. 

 

Findley, Jessica. Text to the author. 10 August 2021. 

 

Grimes, Jodi. Email to Writing Center Staff. 15 July 2021. 

 

Using the Bible as a Source (pp. 71, 240 6.13, 339) 

Things to Remember 

▪ Capitalize basic titles, such as Bible, Old Testament, Koran or Talmud, but resist italics. 

 

▪ Formal titles such The Oxford Annotated Bible or The Holy Word of Qur’an of the Prophet get italics. 

 

▪ Using abbreviations of titles helps add interest and contrast to papers. See chart below for more details. 

Ex: Before God created light, “darkness was over the surface of the deep” (New International Version, 

Gen. 1.2).  After God separated the light from the darkness, “the darkness he called ‘night’” (Gen. 1.5). 

 

Parenthetical References (not specifically mentioned but commonly used) 

When citing a particular passage, use the following order: 

(version of Bible used [in first citation only], book of Bible [abbreviated]  chapter. verse). 
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Ex: (New International Version, Gen. 1.3). 

 

In Text (see MLA Handbook pp. 71.) 

For books and versions of the Bible, do not underline, italicize, or put in quotation marks. The only exception 

occurs when using an individually published edition. 

Ex: Bible    Exodus New Testament        King James Version The Zondervan Study Bible 

Ex: The NIV Serendipity Bible provides questions to assist small group Bible study leaders.  

Works Cited (MLA Handbook, pp. 339) 

Include title of Bible, version, and publication information in the Works Cited. 

 

Ex:  The NIV Serendipity Bible. General editor, Lyman Coleman, Zondervan, 1996. 

Ex: The Holy Bible. English Standard Vers., General editor, Lane Dennis, Crossway, 2005.  

 

Abbreviations (MLA Handbook, pp. 295-8) 
 

Old Testament (OT) 

Gen. Genesis Eccles. Ecclesiastes 

Exod. Exodus Song Sol. Song of Solomon* 

Lev. Leviticus Isa. Isaiah 

Num. Numbers Jer. Jeremiah 

Deut. Deuteronomy Lam. Lamentations 

Josh. Joshua Ezek. Ezekiel 

Judg. Judges Dan. Daniel 

Ruth Ruth Hos. Hosea 

1 Sam. 1 Samuel Joel Joel 

2 Sam. 2 Samuel Amos Amos 

1 Kings 1 Kings Obad. Obadiah 

2 Kings 2 Kings Jon. Jonah 

1 Chron. 1 Chronicles Mic. Micah 

2 Chron. 2 Chronicles Nah. Nahum 

Ezra Ezra Hab. Habakkuk 

Neh.              Nehemiah Zeph. Zephaniah 

Esth. Esther Hag. Haggai 

Job Job Zech.         Zechariah 

Ps. Psalms Mal. Malachi 

Prov. Proverbs  

*Also called Song of S.  Song of Songs 

 

New Testament (NT) 

Matt. Matthew 1 Tim. 1 Timothy 

Mark Mark 2 Tim. 2 Timothy 

Luke Luke Tit. Titus 

John John Philem. Philemon 

Acts Acts Heb. Hebrews 

Rom. Romans Jas. James 

1 Cor. 1 Corinthians 1 Pet. 1 Peter 

2 Cor. 2 Corinthians 2 Pet. 2 Peter 

Gal. Galatians 1 John 1 John 

Eph. Ephesians 2 John 2 John 

Phil. Philippians 3 John 3 John 

Col.  Colossians Jude Jude 

1 Thess. 1 Thessalonians Rev. Revelation 

2 Thess. 2 Thessalonians 

 
The creators of this handout consulted and cited MLA Handbook. 9th ed., Modern Language Association, 2021. and MLA 9th Simplified: Easy Way Guide to MLA 

Handbook, Updated for the MLA 9th Edition Handbook, Appearance Publishers, 2021. 


